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1 Introduction 
IMRData is a data acquisition software for portable flue gas analyzers from IMR.  The software can only be 
used with analyzers which have a serial interface RS-232. 

 

1.1 Minimum System Configurations 
Following configurations are required: 

 IBM compatible computer with Intel Pentium 233 MHz or higher 
Hardware: 

 Serial Interface RS-232 
 Null modem cable 
 Mouse   
 128 MB RAM or more 
 SVGA or higher resolution  
 Min. 4MB of HD space 
 

 Windows 2000/XP 
Software: 

 Microsoft Excel XP1
 

 

To install the software administrator's rights are required in order to have full access to the program folder 
of the Operating system2

1.2 Installation 

. The program is installed in the folder IMR\IMRData, which in the following is 
called „program folder“. The transferred data will be placed in the folder IMRData. This folder is the 
application data folder. 

No administrator rights are needed to run the software, i.e. a user with limited user rights can use the 
program, but he needs the rights to work with the application data folder. The path for the application data 
can be changed by the user after the installation. 

 

Insert the CD to start the installation and run the file setup.exe.  

The installation can be cancelled by clicking cancel. 

 

After the start of the installation the user has to select the language (English or German). 

 

Pressing <OK> selects the chosen language and the next installation window appears. 

                                                
1 Only with option – Direct data transfer to  Microsoft Excel 
2 Usually C:\Program Files 
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Step 1: Start 

Installation begins and will be confirmed by 
clicking <Next>. 

 

 
Step 2: File Folder  

The program will be installed in the selected 
folder (Program Files). The path can be 
changed. Click <Next> to confirm the 
selection and to move on. 

 

 
Step 3: Start menu 

The name of the Start Menu-Folder can be 
changed. Click <Next> to confirm the 
selection and to move on. 

 

 
Step 4: Desktop Icon 

Check the box to create a desktop icon.  Click 
<Next> to confirm the selection and to move 
on. 

 

 
Step 5: Summary 

This window shows the summary of the 
installation data. Clicking <Install> starts the 
installation process. 

 

 
Step 6: Installation finished 

The installation has been finished. Clicking  
<Finish> ends the installation screen. 
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2 Communication 
This software receives the data from the IMR combustion gas analyzers. The transferred data can be 
displayed and stored. The IMR analyzers have a RS232 serial interface which transfers the data (ASCII) in 
real-time to the software.  

 

2.1 Connecting the Analyzer 
The analyzer has 9-pos female D-Sub connector installed. The computer needs a RS232-serial interface as 
well to communicate with the analyzer. The computer connector can be a 9-pos or 25-pos connector. The 
needed communication cable is a so called „Null modem“-cable which can be bought at IMR. Some newer 
computers might not have a serial interface anymore but they usually do have a USB-interface. In this case 
a USB-To-Serial-Adapter will help by transferring the data. IMR does not guarantee though the functionality 
of the program by use of an USB-To-Serial-Adapter. 

 

2.2 Connection-Parameter 
The parameters are already configured, but the COM-port which communicates with the analyzer, must be 
selected. 

Parameters: 

 Baud rate:  9600 Baud 
 Data bits:  8 
 Stop bits:  2 
 Parity:  none 
 Flow control:  Hardware 

  
These parameters can be changed in the following menu:  

File > Change properties > Communication 
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3 Configuration 
The software has to be configured to work with the analyzer. See above to select the correct parameters. If 
the application runs without an analyzer connected to the computer or with wrong parameters, then the 
following screen appears. 

 

 
Toolbar 

 

 

Displayed Data 

            

 

           Data box 

 

 

Status bar          Receiving Data 
            

 

        Language  Communication 

 

 Toolbar: 

 Selection and change of all program functions.  

 Status bar: 

 Shows information regarding the communication with the analyzer. 

 Language selection. 

 Displayed data / Data box: 

 Shows the actual measuring data of the selected parameters. The data boxes can be dropped &  

 dragged with the mouse to a different position. 

 Communication with the analyzer: 

 A red LED shows that the analyzer is not connected to the computer. Double-click the LED to try to  

 connect again. 

 A green LED shows that the analyzer is connected to the computer. 

 Receiving data: 

 The light blinks green when the computer receives data from the analyzer. If no data is received  

 then the light stays grey. 

 Language selection: 

 The language bar shows the language which will be available after clicking the bar. Clicking the  

 language bar selects the new language immediately (English or German). 
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If data is received then the screen looks like this: 

                              

3.1 General Settings 
A new window opens by clicking File > Change Properties. This window shows two tabs. One is the General 
tab and the other the Communication tab. Following changes can be made in the General menu: 

 

 Save position and size after closing the program: 

 The coordinates of the top left corner and the size of the window will 
be stored after closing the program and the window will appear in the 
same size and position when the is opened again. 

  

 Save the visibility of the data boxes after closing the program:  

 The data boxes can be displayed or hidden. This feature can be 
selected within the main window by clicking the right-mouse button 
while on the specific data box. And these settings will be stored. 

  

 Save the visibility of the charts:  

 A chart can be selected for each value. This feature can be selected within the main window by 
clicking the right-mouse button while on the specific data box. And these settings will be stored. 

 Language:  

 The language can be selected. 

 Path for data files:  

 This is the path where the data files will be stored.  
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3.2 Communication settings 
The communication settings can be set in communication menu: 

 Port: 

 COM-Port for the data transfer. 

 Baud rate: 

 Baud rate 

 Data bits: 

 Number of data bits 

 Stop bits: 

 Number of stop bits 

  

 Flow control: 

 Data control between sender and receiver 

 Receiver Timeout (Time in milliseconds): 

 This is the time the software waits to see if data is still transferred or not. If the time expires, then 
the software finishes the measurement.  

  

4 Storing the transferred data 
IMRData has the possibility to store the data in two different ways. The manufacturer configures the 
software before delivery to the user.  

The first kind is to store the data as a CSV-file. In this case the charts will be displayed inside the program 
itself.  

The second kind is to store the data as a Microsoft Excel-File3

4.1 CSV-File 

. In this case the charts will be displayed by 
the created table. 

The standard version of the software saves the data in a so-called CSV-file (Character or Comma Separated 
Values, see: http://de.wikipedia.org/wiki/CSV-Datei

                                                
3 only Microsoft Excel XP 

). The transferred values are stored in a text file. The 
single values are separated by a defined sign, e.g., comma, and the records of one data batch are separated 
by a „carriage return“ and a line feed. 

If a data transfer begins, a new CSV file is created in the application data folder. In the first line the names 
of the single values are written, all other lines contain the measuring data. Such a file could look as follows: 
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It is easy to recognize that the single values are separated by a semicolon. This makes it easier to import 
the data in other applications, e.g., in Microsoft Excel or in OpenOffice.org Calc. A semicolon is a usual 
separator beside comma and tabulator. The semicolon was chosen instead of the comma, so that numerical 
values must not be enclosed in “x.x“; thus a record looks like 
 
 815;Oil Light;ppm;1;13.11.2005;21:06:16;1;2;4,31;1,81;97,41;92,31;110,11;5,31;86,51;2,91;100,51;1,11;1,61;0,21  

 

If there are problems importing the data into an application, then the following information will be needed: 

The first line includes the name of the value and therefore the header for the column. The individual values 
are separated by a semicolon and one data batch is separated by a „carriage return“ and a line feed. 

 

Examples: 

If the CSV file is opened with OpenOffice.org 2.0 Calc a dialog appears. Usually the comma is marked 
automatically. Now the semicolon must be marked to import the data correctly. Press OK to start the import. 

 

Microsoft Excel XP opens the CSV file exactly like an Excel file and imports the data in a table sheet. Should 
this not be done automatically, then the dialog can be opened by clicking:  

„data> external data import> import ... and the choice of the CSV file to the following 3 dialogs: 

 

 

 

 

 

 

 

 

 

Station number;Fuel;Unit;NOx;Date;Time;Number of Samples;Time of Samples;Ambient Air Temperature TA;Oxygen O2;Hydrogen 
Sulphide H2S;Carbon monoxide CO;Hydrocarbons HC;Nitrogen dioxide NO2;Nitric oxide NO;Draft p;Flue-Gas Temperature TG;Carbon 
dioxide CO2;Losses qA;Excess Air LAMBDA 
815;Oil Light;ppm;1;13.11.2005;21:05:52;7;4;0,71;1,71;75,51;122,61;150,51;4,91;153,41;2,41;13,91;0,31;3,81;0,81 
815;Oil Light;ppm;1;13.11.2005;21:05:54;2;7;9,51;0,41;117,21;112,81;312,31;5,61;112,71;1,11;28,71;0,71;9,11;0,01 
815;Oil Light;ppm;1;13.11.2005;21:05:56;3;8;6,71;0,41;98,21;68,11;43,71;6,31;59,81;0,51;61,41;0,61;9,01;0,61 
815;Oil Light;ppm;1;13.11.2005;21:05:58;7;2;11,91;0,11;69,01;199,61;64,81;1,21;34,31;1,11;59,41;0,21;7,01;0,01 
815;Oil Light;ppm;1;13.11.2005;21:06:00;3;2;1,91;0,91;77,91;166,41;383,81;3,01;94,41;3,01;74,51;1,11;6,61;0,11 
815;Oil Light;ppm;1;13.11.2005;21:06:02;4;0;10,31;1,41;10,71;62,71;106,91;1,01;183,51;2,31;55,41;1,11;3,01;0,71 
815;Oil Light;ppm;1;13.11.2005;21:06:04;5;8;3,81;1,01;160,01;193,81;393,51;4,81;66,51;1,91;99,81;0,21;5,71;0,71 
815;Oil Light;ppm;1;13.11.2005;21:06:06;7;7;9,51;1,41;3,61;110,01;234,91;9,41;67,21;0,01;40,51;0,51;9,11;0,61 
815;Oil Light;ppm;1;13.11.2005;21:06:08;3;6;7,91;1,21;43,41;113,31;169,61;3,61;50,81;4,91;30,91;0,01;7,41;0,91 
815;Oil Light;ppm;1;13.11.2005;21:06:10;2;4;4,51;0,31;193,91;43,81;54,11;9,41;168,91;1,61;86,71;0,91;8,71;0,41 
815;Oil Light;ppm;1;13.11.2005;21:06:12;8;1;11,61;0,11;91,41;164,41;22,71;7,11;177,01;3,41;52,11;1,21;9,41;0,51 
815;Oil Light;ppm;1;13.11.2005;21:06:14;3;1;6,41;0,51;76,11;71,31;63,91;1,31;140,91;0,51;112,11;0,01;7,81;0,01 
815;Oil Light;ppm;1;13.11.2005;21:06:16;1;2;4,31;1,81;97,41;92,31;110,11;5,31;86,51;2,91;100,51;1,11;1,61;0,21 
815;Oil Light;ppm;1;13.11.2005;21:06:18;7;5;11,81;0,41;20,31;40,31;333,61;0,01;183,21;4,01;116,81;1,01;6,81;0,51 
815;Oil Light;ppm;1;13.11.2005;21:06:20;5;5;1,71;1,91;20,31;90,01;371,81;2,91;128,81;2,21;94,41;1,41;8,91;0,71 
815;Oil Light;ppm;1;13.11.2005;21:06:22;9;1;10,61;0,01;22,81;45,61;237,71;4,81;167,41;2,61;80,71;0,31;4,11;0,71 
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4.2 EXCEL-File 
The second and optional version of the software saves the data in an EXCEL-file. Only Microsoft Excel XP-
Files4 are supported by the program. In this case the transferred data is written right into an EXCEL spread 
sheet. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

                                                
4 Microsoft Excel XP must be installed and working 
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5 Display of the data 
The measured values can be shown as a number (text), as a chart or in a report. 

5.1 Display as a number 
Within the main window the measuring values are displayed as numbers (text). The application is configured 
to show the most important measuring values. With the help of a pop-up menu (right mouse click within the 
main window) other values can be chosen to be displayed or to be hidden: 

 

Checkmarks in front of the parameters show that this parameter is displayed.  

By clicking the value the checkmark is either removed or appears. 

 

 

A right mouse click within the text box opens the pop-up window for this parameter. Now the displayed data 
can be hidden or a chart can be opened for this parameter. 

The text boxes can be dragged & dropped to other places.  

 Mouse cursor over the text box 

 Click the left button and keep it pressed 

 Move the mouse cursor to the desired spot 

 Release left button 
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Instead of re-positioning all values it might be easier to assign other parameters to the existing spots. 
Picture 1 shows that the parameter SO2 should be assigned to the spot which shows at the moment the 
value of CO2. Picture 2 shows the window after the change. The name of the chosen value might be red 
after the change. This means that this parameter was already assigned to another text box and this should 
be avoided. Nevertheless, at first sight a double allocation is not recognized. 
 
 

 
Picture  1: Assignment of another parameter 

 
Picture  2: Parameters changed; double assignment 

 

This is due to the fact that SO2 was already assigned, though the text box was hidden. If the pop-up menu 
is opened then two entries are shown in grey, these are the entries which are no more unequivocal (picture 
3). In this case it is advisable to cancel the new assignment and to hide, instead, the text box for CO2 and 
to show SO2 instead, see picture 4. Afterwards the text box can be dropped & dragged to the desired 
position. 

 

 
Picture 3: Check for double assignments 

 
Picture  4: Change of displayed and hidden values 
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Picture 5: Before the new assignments 

 
Picture  6: After the new assignment, double assignment 

 
Picture 7: After the re-assignment 

Here is another example of a double assignment. 
The Excess Air value text box was assigned 
originally to SO2 (pictures 5 and 6). Now the names 
of the double assignments both are shown red, and 
the double assignment is easy to recognize. Now 
one of the two text boxes should be differently 
assigned, e.g., the right text box could show SO2 
(picture 7). 
 
 

If the original layout of the text boxes is not satisfactory then it might be better to display all parameters 
and then the re-arrangement is easier. 

 

5.2 Line diagrams 
Line diagrams can be displayed to (almost) each value. The charts can be displayed by opening the pop-
menu of the desired parameter. 

IMRData can show line diagrams in two different kinds, dependent of the software version. If the data is 
stored in a CSV file, then line diagrams are shown within the application. If the data is stored in Microsoft 
Excel-Files5

5.2.1 Line diagrams within the application 

, then the line diagrams are displayed within the table in which the data is stored. 

 

It is easy to recognize in the following picture that the line diagrams are adjustable and can be placed 
therefore on the whole desktop. The size of the line diagram windows is changeable, also the position.  

If the line diagram is closed, then it can be made visible by opening the pop-up menu of the specific text 
box.  

 

 
                                                
5 Only for Microsoft Excel XP 
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Line diagrams can be configured and show additional information. 

 

 

 

               Toolbar   

               Additional Information  

          

 

                         Line Diagram 

 

 

 

 

 

 

 

    

         Time Period X-Axis    

Hide/show cross dotted line or diagram     Hide Tool tips / Hints to the value 

 Hide / show cursor cross 

 

As shown on top, the tool bar is never as above, because to explain the different configuration possibilities 
all possible icons are listed. They form in each case one group. If, e.g., in the diagram a mark cross is 
visible, only the icon to hide the mark cross is indicated.  

A marked cross helps to navigate within the diagram (zooming, scrolling, marking). 

A cursor cross will only be shown when the mark cross is visible. The cursor cross shows the middle of the 
mark cross. 

The transferred values are shown in the diagram with small red squares which can be connected by a line. It 
is also possible to show only the measuring points. In this case the „dotted line“ icon must be chosen. If the 
values should be shown as a line diagram then the „line diagram“ icon should be checked.  

Move the mouse cursor over a measuring point then the date, the time and the value is indicated and in a 
special area, the tool tip or hint, provided that tool tips / Hints was activated. 

The box at the end is always indicated. This box selects how big the visible area of the X axis should be. If 
more measuring values exist than within the desired area can be shown, the diagram scrolls automatically. 
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Below the tool bar there is an other strip in which the following values are shown: 

 

 (1) (2) (3) (4) (5) (6) 

Green is  (1) Average value, (2) Minimum, (3) Maximum value of the total measurement, yellow is  
(4) date, (5) time, (6) value of the actual value (mouse over measuring point). 

If the time period is longer than the chosen area of the X axis, then the display scrolls automatically. 
Nevertheless a manual scroll is possible too.  Press and hold the right mouse key while on the diagram and 
then move the mouse then in the desired direction.  

The indicated area can be zoomed. Press and hold the left mouse key within the diagram and move from the 
top left to the bottom right around the area to be zoomed in. To reduce it back to the original resolution the 
mouse has to be moved from the bottom right to the top left. 

5.2.2 Line diagrams in Microsoft EXCEL 

The creation of line diagrams in Excel occurs in a very easy way. The automatically generated line diagram 
indicates always all values which were transferred since the beginning of the measurement. Automatic 
scrolling and zooming is not realized at the moment. If the application was configured correctly then it 
notices the cell position of the upper left corner and the size of the line diagram while finishing the 
application. 

During a data transfer and data storage the configuration of the line diagrams should not be changed, 
because it might block the diagrams for the application IMRData. Because the application must adapt the 
measuring area with every record which comes in. In addition, the application blocks the manual exiting of 
the Excel file during a data transfer and data storage. 

If the data transfer is finished, the Excel table and the diagrams contained in it can be formatted as desired. 

An example of an Excel file with line diagram: 
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6 Reports 
Reports can be created only if the software communicates with the measuring instrument.  
Two different reports can be shown:  
A report with momentary values which indicates the values of the last received data batch. 
A report with average values which calculates all statistical values (Mean value and Min-/Max-value and 
beginning values and final values) of all transferred values.  
Both reports are nearly the same in the construction.  
 
 

 
The report file has to be opened to view a momentary report (report > preview actual values). To view an 
average value report the file report > preview average values has to be opened. The preview offers the 
possibility to print out the report.  
 
To print the report without a preview select file> print. 
 

6.1 Momentary values 
A report for momentary values looks like this6: 

 

                                                
6 Note: The values in the report are not only transferred values, but also calculated values. 
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6.2 Average values 
A report for average values looks like this: 
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7 Miscellaneous 

7.1 Language 
The application is laid out in several languages, at the moment the choice exists between German and 
English.  

The language can be changed without having to restart the program. This is possible by choosing the 
language in the settings menu or by clicking on the language symbol within the status line. 

7.2 Printer 
To select and configure a printer the menu File > Printer properties has to be opened.  

 

The language in this dialog is always the same as the language of the 
operating system.  

 

 

 

 

 

 

7.3 Program information 
An information window opens through the menu point Help> Info. Within this window the name of the 
application, a short description, the installed version, the name of the operating system, the copyright and 
the contact address of the manufacturer is shown. 
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